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AKVIS DECORATOR 9.0 | ЗАМЕНА ТЕКСТУРЫ И ПЕРЕКРАСКА ПОВЕРХНОСТИ

Хотите быстро получить изображение автомобиля в змеиной коже или статуи в платье из струящегося шелка? AKVIS
Decorator позволяет создавать самые разнообразные вещи, от реалистичных до невообразимых!

Программа изменяет поверхность объекта, накладывает новую текстуру, сохраняя объем, рельеф, складки, тени
исходного изображения.

Нужно просто выделить часть фотографии: одежду, мебель, лицо или фигуру человека, — выбрать новую текстуру и
нажать на кнопку "Пуск". И вот на чаше появился изысканный орнамент, автомобиль словно сложен из кирпичиков, а
статуя облечена в красивое платье. Вы можете подшутить над своим другом, "нарисовав" ему прическу из металла,
превратить стеклянный сосуд в золотую вазу, натянуть шкуру леопарда на изображение ноутбука и многое другое!

В вашем распоряжении разнообразие вариантов, от природных материалов до причудливых узоров. В программе
представлена богатая  Библиотека текстур с более 1800  образцами  поверхностей, среди которых текстуры дерева,
металла, камня, травы, тканей и другие. Можно использовать и свои образцы.

После выбора текстуры можно ее изменить, приспособив к поверхности, указав степень искривления текстуры,
определив положение источника света, яркость и объемность изображения, распределение света и тени. Можно
сгенерировать текстуру на основе уже готовой: повернуть ее, изменить цвет текстуры, поиграть с масштабом узора.
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Даже небольшие изменения могут иметь большое значение. Примените разные текстуры к одному и тому же
изображению и посмотрите, как та или иная деталь влияет на общее впечатление.

Сфера применения программы разнообразна. Дизайнеры и декораторы применяют программу для разработки проектов.
С помощью программы можно быстро и эффективно подобрать варианты оформления интерьера, за несколько минут
подготовить каталог товаров в интернет-магазине. Decorator идеально подходит для создания набора одних и тех же
предметов, отличающихся лишь материалом, цветом, наличием узора.
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Есть возможность и простого перекрашивания объекта. Выбрав нужный оттенок, можно задать степень влияния
яркости и объема исходного изображения на результат.

Как и прочие программы АКВИС, Decorator обладает простым и удобным в использовании интерфейсом, понятным даже
новичку в компьютерной графике.  Подсказки в нижней части окна помогут освоиться с программой, возможность
переключаться одним кликом мыши между оригиналом и результатом — подобрать наилучший вариант.
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AKVIS Decorator представлен в виде плагина для графических редакторов (plugin)  и  в  виде  отдельной,
самостоятельной, программы (standalone), не требующей наличия фоторедакторов.

Плагин совместим с AliveColors, Adobe Photoshop, Corel PaintShop Pro и другими графическими редакторами.
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УСТАНОВКА НА WINDOWS

Следуйте инструкции, чтобы установить программу AKVIS на Windows.

Для установки программы необходимо обладать правами администратора.

Перед установкой плагина необходимо закрыть графический редактор, в который будет устанавливаться плагин. Если
установка плагина была выполнена при запущенном графическом редакторе, то его необходимо перезапустить.

 

1. Запустить программу установки двойным щелчком по файлу exe.
2. Выбрать язык программы и нажать на кнопку Установить (Install).
3. Ознакомиться с  Лицензионным Соглашением, при согласии с его условиями выбрать пункт "Я принимаю

условия лицензионного соглашения" ("I accept the term in the license agreement") и нажать на кнопку Далее
(Next).

4. Для установки  плагина нужно выбрать из списка графический редактор (или редакторы), в который будет
устанавливаться плагин.

Для установки  версии standalone (отдельной программы) должен быть выбран соответствующий вариант —
Standalone.
Для создания ярлыка программы на рабочем столе должен быть выбран компонент Ярлык на рабочий стол
(Desktop Shortcut).

Нажать на кнопку Далее (Next).

5. Нажать кнопку Установить (Install).
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6. Запустится процесс установки программы.

7. Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, ссылки на обучающие
статьи и специальные предложения. Для этого введите свой адрес e-mail и подтвердите согласие с политикой
конфиденциальности.
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8. Нажать кнопку Готово (Finish) для выхода из программы инсталляции.

После установки программы AKVIS Decorator в главном меню Start (Пуск) появится пункт AKVIS -> Decorator, a на
рабочем столе — ярлык программы AKVIS Decorator (если при установке было выбрано создание ярлыка).

После установки  плагина Decorator в меню фильтров (эффектов) редактора появится новый пункт  AKVIS –
Decorator. Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop: Filter ->
AKVIS -> Decorator, в AliveColors: Эффекты -> AKVIS -> Decorator.

Внимание! Если плагин не установился в графический редактор автоматически, можно подключить его вручную. 
Обычно достаточно просто скопировать файл 8bf из папки AKVIS в папку Plug-ins графического редактора. Например,
для Adobe Photoshop CC скопируйте 8bf в папку Program Files\Common Files\Adobe\Plug-Ins\CC. 
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УСТАНОВКА НА MAC

Следуйте инструкции, чтобы установить программу AKVIS на Mac.

Для установки программы необходимо обладать правами администратора.

 

1. Открыть виртуальный диск dmg:

- akvis-decorator-app.dmg для установки версии Standalone (отдельной программы)

- akvis-decorator-plugin.dmg для установки версии Plugin.

2. Ознакомиться с Лицензионным соглашением и нажать кнопку Agree.

3. Откроется окно  Finder с приложением  AKVIS Decorator (в случае установки отдельной программы) или, в
случае установки плагина, с папкой AKVIS Decorator Plugin.

 

Для установки версии standalone приложение AKVIS Decorator переместить в папку Applications.

Для установки версии plugin приложение AKVIS Decorator Plugin перенести в папку с плагинами графического
редактора:

AliveColors: любая папка, указанная в настройках редактора,

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC,

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins,

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-Ins.
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Плагины на Mac
(кликните на изображение для увеличения)

После установки плагина Decorator в меню фильтров (эффектов) редактора появится новый пункт AKVIS –>
Decorator. Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop:
Filter -> AKVIS -> Decorator, в AliveColors: Эффекты -> AKVIS -> Decorator.

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.

Также можно запустить программу AKVIS из приложения  Фото, выбрав команду  Изображение ->
Редактировать в (в High Sierra и более поздних версиях macOS).

 

AKVIS Decorator

11

http://akvis.com/img/examples/decorator/install-software/setupmac4-b.jpg


УСТАНОВКА НА LINUX

Следуйте инструкции, чтобы установить программу AKVIS на Linux.

Примечание: Программы AKVIS совместимы только с  64-битным ядром Linux версии 5.x или более поздней.
Узнать версию ядра можно с помощью команды uname -srm.

Установка в системах на основе Debian (например, Astra Linux).

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Создать каталог для хранения ключей: 

sudo mkdir -p /usr/share/keyrings
3. Скачать ключ, которым подписан репозиторий: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
или wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Добавить репозиторий в список, где система ищет пакеты для установки: 
e c h o  ' d e b  [ a r c h - = i 3 8 6  s i g n e d - b y = / u s r / s h a r e / k e y r i n g s / a k v i s . g p g ]  h t t p s : / / a k v i s -
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Обновить список известных пакетов: 
sudo apt-get update

6. Начать установку программы AKVIS Decorator: 
sudo apt-get install akvis-decorator

7. Установка завершена.

Запустить AKVIS Decorator через терминал или ярлык программы.

8. Для автоматического обновления используется команда: 
sudo apt-get upgrade

для удаления программы: 
sudo apt-get remove akvis-decorator --autoremove

 

Установка в системах на основе RPM (например, РЕД ОС).

1. Запустить терминал.
2. Зарегистрировать ключ, которым подписан репозиторий 

sudo rpm --import https://akvis.com/akvis.asc
3. Добавить репозиторий в систему 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Обновить список пакетов

при использовании менеджера пакетов dnf: 
sudo dnf update

при использовании менеджера пакетов yum: 
sudo yum update

5. Установить программу AKVIS Decorator

при использовании менеджера пакетов dnf: 
sudo dnf install akvis-decorator

при использовании менеджера пакетов yum: 
sudo yum install akvis-decorator

6. Установка завершена.

Запустить AKVIS Decorator через терминал или ярлык программы.

7. Для автоматического обновления

при использовании менеджера пакетов dnf: 
sudo dnf upgrade

при использовании менеджера пакетов yum: 
sudo yum upgrade

8. Для удаления программы

при использовании менеджера пакетов dnf: 
sudo dnf remove akvis-decorator

при использовании менеджера пакетов yum: 
sudo yum remove akvis-decorator
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Установка в системе ALT Linux.

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Войти как root-пользователь: 

su -
3. Добавить репозиторий в систему: 

apt-get install akvis-repo
4. Обновить список известных пакетов: 

apt-get update
5. Установить программу AKVIS Decorator: 

apt-get install akvis-decorator
6. Установка завершена.

Запустить AKVIS Decorator через терминал или ярлык программы.

7. Для автоматического обновления используется команда: 
apt-get dist-upgrade

для удаления программы: 
apt-get remove akvis-decorator

 

Установка в системе openSUSE.

1. Запустить терминал.
2. Войти как root-пользователь.
3. Добавить ключ, которым подписан репозиторий 

rpm --import http://akvis.com/akvis.asc
4. Добавить репозиторий в систему 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Обновить список пакетов: 

zypper ref
6. Установить программу AKVIS Decorator: 

zypper install akvis-decorator
7. Установка завершена.

Запустить AKVIS Decorator через терминал или ярлык программы.

8. Для автоматического обновления используется команда: 
zypper update

для удаления программы: 
zypper remove akvis-decorator

 

Для правильного отображения интерфейса программы рекомендуется установить композитный менеджер Compton или
Picom.
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АКТИВАЦИЯ ПРОГРАММЫ

Внимание! Ваш компьютер должен быть подключен к сети Интернет.

Если подключение к Интернет недоступно, ниже предлагается альтернативный способ активации.

 

Скачать установочный файл AKVIS Decorator (на странице программы или на странице загрузки).

Запустить скачанный файл и установить программу, следуя подсказкам мастера установки.

Запустить установленную программу. Окно О программе всегда показывается при запуске незарегистрированной
копии программы. Кроме того, окно  О программе выводится при нажатии кнопки   на Панели управления

программы.

При работе с плагином в редакторе Adobe Photoshop окно О программе может быть вызвано на экран выбором
команды меню Help -> About Plug-In –> Decorator на Windows, Photoshop -> About Plug-In –> Decorator на Mac.

 

При нажатии кнопки Попробовать откроется окно, где можно выбрать тип лицензии для ознакомления. Если пробный
период истёк, кнопка будет неактивна.

В течение ознакомительного периода (10 дней) доступна любая лицензия: Home (Plugin либо Standalone), Deluxe или
Business. При выборе лицензии рядом будет отображен пояснительный текст с кратким описанием данного типа
лицензии. В зависимости от выбора будут доступны разные возможности AKVIS Decorator.

Для получения более полной информации о версиях и лицензиях программы AKVIS Decorator смотрите сравнительную
таблицу.

 

При нажатии кнопки Купить будет открыто окно, где необходимо указать приобретаемый тип лицензии.

После выбора лицензии необходимо снова нажать кнопку Купить. В браузере откроется страница заказа, где можно
продолжить подбор программ либо приступить к оформлению покупки.

После заполнения формы и проведения денежной транзакции серийный номер будет выслан в течение нескольких
минут.

 

Чтобы зарегистрировать программу, нажать на кнопку Активировать. Откроется следующее окно:

AKVIS Decorator
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В поле Имя пользователя ввести имя, на которое будет зарегистрирована программа.

Внимание! Длина имени пользователя на кириллице не должна превышать 21 символ.

В поле Серийный номер ввести номер, полученный после оплаты заказа.

Ниже выбрать способ активации - через прямое соединение с сервером или через электронную почту.

Прямое соединение с сервером

Рекомендуется данный способ активации, как наиболее быстрый.

Компьютер должен быть подключен к сети Интернет.

Нажать на кнопку Активировать для завершения активации.

Отправить запрос по e-mail

Eсли был выбран способ активации через e-mail, то при нажатии на кнопку Активировать будет автоматически
создано письмо, которое, не редактируя, необходимо отправить по указанному адресу.

Если компьютер не подключен к Интернет, нужно записать созданное письмо на внешний носитель (диск или
"флешку") и отправить с другого компьютера, на котором есть доступ к сети. Все, что нам нужно, уже будет
записано в самом письме.

Если письмо не создается, просто пришлите нам серийный номер (код лицензии) программы и HardwareID (HWID)
компьютера, на котором установлена программа.

В ответ будет получено письмо с вложенным файлом Decorator.lic, который следует поместить в папку, где
хранится лицензионная информация о программе. Это папка AKVIS в Общих документах пользователей:

Windows:

C:\Users\Public\Documents\AKVIS;

Mac:

/Users/Shared/AKVIS или домашняя папка пользователя;

Linux:

/var/lib/AKVIS.

Активация программы завершена.

AKVIS Decorator
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При желании можно произвести апгрейд до версии Home Deluxe или Business, доплатив разницу в цене. Для этого в
окне О программе необходимо нажать кнопку Улучшить (в зарегистрированной версии появляется на месте кнопки
Купить).

В открывшемся окне выбрать желаемую лицензию и нажать кнопку  Улучшить. При этом в браузере откроется
страница заказа, где можно оплатить выбранный апгрейд.

После оплаты вы получите сообщение, что ваша лицензия обновлена, после чего потребуется переактивировать
программу.

При нажатии кнопки Отменить происходит возврат в окно О программе.

При возникновении вопросов или проблем обратитесь в службу поддержки - support@akvis.com.
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ

AKVIS Decorator может работать как отдельная программа или как плагин к графическому редактору.

Запустить отдельную программу можно обычным способом.

Для вызова плагина необходимо открыть изображение в редакторе, а затем выбрать пункт AKVIS –> Decorator
из меню фильтров.

Окно программы AKVIS Decorator имеет вид:

Элементы окна программы:

Основную часть окна программы  AKVIS Decorator занимает  Окно изображения с закладками  Оригинал  и
Обработка. В закладке  Оригинал находится исходное изображение, в закладке  Обработка − применяются
инструменты и отображается результат. Переключаться между ними можно щелчком левой кнопки мыши по названию
закладки.

Настроить  внешний вид Окна изображения и закладок можно с помощью кнопок в нижней части  Панели
инструментов.

 

Вверху расположена Панель управления с кнопками:

Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Decorator.

Кнопка   (только в отдельной программе) предназначена для открытия изображения. Открыть изображение

можно с помощью горячих клавиш Ctrl+O  на Windows, ⌘ +O  на Mac.
Кнопка   (только в отдельной программе) предназначена для сохранения отредактированного изображения.

Диалог сохранения файла вызывается также нажатием клавиш Ctrl+S  на Windows, ⌘ +S  на Mac.
Кнопка   (только в отдельной программе) предназначена для  вывода изображения на печать. Быстрая

отправка на печать производится нажатием клавиш Ctrl+P  на Windows, ⌘ +P  на Mac.
Кнопка   предназначена для загрузки файла с выделением (.decor).

Кнопка   предназначена для сохранения выделенных областей в отдельный файл с расширением .decor.

Кнопка   предназначена для отмены последнего действия. Если нажать на эту кнопку несколько раз, будут
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отменены несколько последних действий. Отменить действие можно с клавиатуры с помощью комбинации клавиш
Ctrl+Z  на Windows, ⌘ +Z  на Mac.
Кнопка   позволяет восстановить действие, отмененное командой  . Восстановить действие можно с

клавиатуры с помощью комбинации клавиш Ctrl+Y  на Windows, ⌘ +Y  на Mac.
Кнопка   запускает обработку изображения. Обработку можно запустить нажатием клавиш  Ctrl+R   н а

Windows, ⌘ +R  на Mac.
Кнопка   (только в плагине) предназначена для применения результатов и закрытия окна плагина.

Кнопка   предназначена для вызова сведений о программе.

Кнопка   (либо клавиша F1 ) предназначена для вызова справки помощи по программе.

Кнопка   вызывает диалог изменения Настроек программы.

Кнопка   вызывает панель оповещений со свежими новостями о программе.

 

Слева от Окна изображения расположена Панель инструментов.

Параметры выбранного инструмента будут показаны на Панели настроек или в меню, всплывающем при щелчке
правой кнопки мыши по изображению.

 

Перемещение по изображению и масштабирование осуществляется с помощью Навигатора. Рамкой в Навигаторе
отмечена часть изображения, которая в данный момент является видимой в Окне изображения; области за пределами
рамки будут затенены. Рамку можно перетаскивать, меняя видимую часть изображения. Для перемещения рамки
необходимо поместить курсор внутрь рамки и, удерживая левую кнопку мыши, выполнить перетаскивание.

Для прокрутки изображения в Окне изображения можно использовать полосы прокрутки или нажать на пробел и
перетаскивать изображение левой кнопкой мыши. Прокруткой колёсика мыши изображение можно перемещать вверх-
вниз, удерживая  Ctrl  на Windows,  ⌘  на Mac – вправо-влево, удерживая  Alt  на Windows,  Option  на  Mac −
масштабировать. При щелчке правой кнопкой мыши на полосе прокрутки появляется меню быстрых перемещений.

Масштабировать изображение в Окне изображения можно с помощью ползунка. При перемещении ползунка вправо
происходит увеличение масштаба; влево − уменьшение.

Также масштаб изображения изменится, если ввести в поле масштабирования новый масштабный коэффициент. Часто
используемые масштабы помещены в выпадающее меню поля масштабирования.

Для увеличения масштаба изображения можно воспользоваться клавиатурными сокращениями:  +   и   Ctrl++   н а
Windows, ⌘ ++  на Mac, для уменьшения масштаба -  и Ctrl+-  на Windows, ⌘ +-  на Mac.

 

Под Навигатором расположена Панель настроек, на которой можно задать параметры наложения текстуры и цвета
на изображение.

Кнопка Вернуть установки по умолчанию позволяет сбросить значения параметров до исходных.

При необходимости можно воспользоваться подсказкой − кратким описанием параметров и кнопок, на которые
наводится курсор. Изменить местоположение окна подсказки можно в Настройках программы.
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РЕЖИМЫ ПРОСМОТРА ИЗОБРАЖЕНИЯ

В нижней части Панели инструментов расположены три кнопки, отвечающие за внешний вид Окна изображения.

Кликом мыши по первой кнопке открывается вложенное меню, где представлены различные варианты просмотра
исходного и обработанного изображений:

- При выборе   отображается стандартное Окно изображения с закладками Оригинал и Обработка.

- При нажатии на   или   Окно изображения разбивается на два окна (по вертикали и по

горизонтали соответственно). Часть исходного и часть обработанного изображения, видимые в окнах
Оригинал и Обработка, складываются вместе, образуя целую картинку.

При таком разбиении разделяющую линию можно двигать с помощью курсора мыши, изменяя соотношение
размеров окон Оригинал и Обработка.

- При нажатии на   или   Окно изображения также делится пополам (по вертикали или по

горизонтали). В отличие от предыдущего разделения, здесь в каждом из окон отображается один и тот же
фрагмент изображения до и после обработки.

Примечание: Использовать различные режимы просмотра удобно в тех случаях, когда вы хотите увидеть и
сравнить фрагмент исходного и обработанного изображения на одном экране. Если же вы хотите взглянуть на
готовое изображение в целом, то лучше выбрать режим со стандартным Окном изображения.

При нажатии кнопки   закладки До и После поменяются местами.
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При выборе последней кнопки также откроется вложенное меню. Используя находящиеся в нем кнопки  , 

и  , можно изменить цвет фона Окна изображения на белый, серый или черный либо, нажав кнопку  ,

вызвать диалог Выбор цвета и выбрать цвет фона на свой вкус.
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РАБОТА С ПРОГРАММОЙ

AKVIS Decorator может работать как отдельная программа или как плагин к графическому редактору.

Для обработки изображения необходимо выполнить следующие действия:

Шаг 1. Открыть изображение.

- В отдельной программе (файл в формате TIFF, BMP, JPEG, WEBP или PNG):

Диалоговое окно  Открыть изображение можно вызвать сразу после запуска программы с помощью
двойного щелчка мыши в области Окна изображения или кнопкой   на Панели управления. Кроме

того, можно перетащить ярлык изображения в открытое окно программы.

- При работе с плагином:

В графическом редакторе с помощью команды меню Файл -> Открыть или сочетания клавиш  Ctrl+O  на
Windows, ⌘ +O  на Mac.

Вызвать плагин AKVIS Decorator с помощью команды меню:

в AliveColors: Effects -> AKVIS -> Decorator;
в Adobe Photoshop: Filter –> AKVIS –> Decorator;
в Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Decorator;
в Corel Photo-Paint: Effects –> AKVIS –> Decorator.

Шаг 2. Выделить объект, на который будет накладываться текстура с помощью инструментов выделения: , 

, , , , .

Параметры выбранного инструмента будут показаны в окне, всплывающем по щелчку правой кнопки мыши.

При работе с плагином выделение может быть передано из графического редактора.
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Рекомендуется сохранить выделение в файл с расширением  .decor с помощью кнопки   − тогда на любом

этапе работы в последующем можно подгрузить его к картинке (кнопка  ).

Шаг 3. На выделенный объект наложить  текстуру или перекрасить его в  другой цвет. Параметры эффекта
регулируются на Панели настроек.
Шаг 4. Нажать на кнопку  , чтобы запустить процесс обработки. Результат наложения будет показан в

закладке Обработка. При необходимости продолжить настройку параметров, отредактировать выделение или
создать новое и запустить расчет снова.

Шаг 5. Доработать изображение с помощью инструментов Кисть возврата  и Размазывание  (только

для лицензий Home Deluxe и Business).
Шаг 6. В стандалон-версии AKVIS Decorator есть возможность распечатать изображение.
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Шаг 7. Сохранить полученное изображение.

- В отдельной программе:

Нажать на кнопку  , в диалоговом окне Сохранить изображение ввести имя файла, указать формат

(TIFF, BMP, JPEG, WEBP или PNG) и выбрать каталог, в который необходимо сохранить файл.

- При работе с плагином:

Применить результат нажатием кнопки  .

В графическом редакторе вызвать диалог сохранения файла командой меню  Файл -> Сохранить как,
ввести имя файла, указать формат и выбрать каталог, в который необходимо сохранить файл.
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РАБОТА С ИНСТРУМЕНТАМИ

Все инструменты программы делятся на три группы:  инструменты выделения, инструменты постобработки  и
вспомогательные. Параметры инструментов показываются на Панели настроек или по щелчку правой кнопкой мыши в
пределах Окна изображения.

Панель инструментов

Примечание:

С помощью кнопок    и    на Панели управления можно отменить/повторить действия, произведенные

инструментами  , , , , , , , .

 

Инструменты выделения:

С помощью инструментов можно выделить области изображения, где будет наложена текстура или изменен цвет.

Быстрое выделение . Инструмент служит для быстрого выделения участков изображения на основе оценки

цветов соседних пикселей. При движении кисти область выделения расширяется, находит контуры объектов и
следует им.

Размер (1-200) определяет диаметр выделяющего элемента. Все цвета, попавшие в область действия
инструмента, будут выделены на всем изображении (с учетом границ и значения параметра Допуск).

Допуск (0-100). Чем выше значение параметра, тем больше оттенков цветов попадет в выделение.

Использовано Быстрое выделение

 

Стандартные инструменты выделения предназначены для создания областей выделения геометрической или
произвольной формы.

Прямоугольное выделение . Инструмент позволяет выделять прямоугольные или квадратные

фрагменты изображения. Создаётся перетаскиванием курсора в сторону с нажатой левой кнопкой мыши.
Эллиптическое выделение . Инструмент предназначен для выделения эллиптических или круглых

фрагментов. Создаётся перетаскиванием курсора в сторону с нажатой левой кнопкой мыши.
Свободное выделение . Инструмент позволяет выделять фрагмент произвольной формы. Создаётся

проведением линии вокруг объекта. При отпускании левой кнопки мыши контур замыкается.
Многоугольное выделение . Инструмент позволяет создать произвольный контур выделения из

отрезков прямых. Для замыкания контура необходимо соединить крайние точки либо сделать двойной клик
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мыши в любом месте изображения.

Размытие (0-250). Увеличение параметра смягчает края выделения за счёт плавного уменьшения
чёткости.

Чек-бокс Сглаживание позволяет устранить неровности контура выделения (т. н. "зубчики"). Чтобы
край области получился сглаженным, чек-бокс должен быть включен до использования инструмента.

Чек-бокс От центра задаёт способ создания выделения. Если чек-бок активен, выделяющий контур
появляется при движении от центра наружу. При выключенном чек-боксе выделение создаётся
движением от одного угла к другому.

Выпадающий список Стиль позволяет указать размер создаваемой области.

Нормальный. Размер выделения определяется перемещением курсора.

Заданный размер. Позволяет создать область выделения с точными размерами (в пикселах). В
этом случае контур выделения создаётся одним кликом.

Отношение сторон. Соотношение ширины и высоты контура остаётся фиксированным.

Использовано Прямоугольное выделение

 

Общие параметры инструментов выделения:

Режимы выделения (в виде пиктограмм) − логические операции, которые определяют результат
взаимодействия выделенных областей.

Новое . При создании нового выделения старое выделение исчезает.

Сложение . Новое выделение добавляется к существующему. Режим активируется при удержании

клавиши Ctrl .

Вычитание . Общая часть исключается из выделенной области. Режим активируется при

удержании клавиши Alt .

Пересечение . Остаётся только область перекрытия выделений.

При нажатии кнопки   открывается список действий, которые можно произвести с созданным

выделением: Инвертировать выделение (комбинация клавиш Ctrl+I ) и Снять выделение (комбинация
клавиш Ctrl+D ).

 

Инструмент Ластик  предназначен для стирания выделения.

 

Инструменты постобработки (только для лицензий Home Deluxe и Business):

Размазывание . Инструмент предназначен для смешивания цветов на изображении и удаления неровностей

закраски.

Параметры инструмента:

Размер (1-300). Диаметр инструмента.

Жёсткость краёв (0-100). Степень размытости внешнего края. Чем больше значение параметра, тем
сильнее загрубляется край инструмента.

Сила (1-100). Растянутость цветов в мазке. Чем выше значение параметра, тем дальше размазывается
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До применения инструмента Использован инструмент Размазывание

До применения инструмента Использована Кисть возврата

элемент изображения.

Кисть возврата . Инструмент восстанавливает изображение до исходного состояния.

Размер (1-1000). Максимальная ширина линии, которую можно получить с помощью кисти (в пикселах).

Жесткость (0-100). Степень размытости внешнего края инструмента. Чем больше значение параметра, тем
сильнее загрубляется край. При жёсткости 100 будет наблюдаться резкая граница между восстановленной
и невосстановленной областью; с уменьшением жёсткости переход от необработанной области
изображения к обработанной будет более плавным.

Сила (1-100). Степень восстановления исходного состояния. При небольших значениях параметра
происходит частичное восстановление изображения и его смешивание с текущим состоянием; при 100
исходное изображение восстанавливается полностью.

 

Bспомогательные инструменты (активны в обеих закладках и доступны для всех лицензий):

Инструмент Рука  позволяет прокручивать фотографию, когда она не помещается в Окне изображения при

выбранном масштабе. Для прокрутки необходимо нажать на кнопку, подвести курсор к изображению и,
удерживая левую кнопку мыши нажатой, переместить в нужную сторону.
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Двойным щелчком по кнопке   изображение масштабируется под размер окна программы.

Инструмент  Лупа  предназначен для изменения масштаба изображения. Для увеличения масштаба

необходимо щёлкнуть левой кнопкой мыши по изображению в окне программы. Для уменьшения масштаба
изображения щелчок производится с нажатой клавишей  Alt . Для быстрого вызова инструмента используется
клавиша Z .

Двойным щелчком по кнопке   можно развернуть изображение в натуральную величину (100%).

Инструмент Кадрирование  (только в отдельной программе) позволяет отсечь часть изображения, оставив

нужный фрагмент. Настройки инструмента будут показаны на Панели настроек.

Примечание: Инструмент применяется к исходному изображению! Используйте Кадрирование до того, как
выделили объект.

Чтобы отсечь области, не попавшие в кадр, следует нажать  OK или клавишу  Enter . Если нужно отменить
операцию − кнопку Отмена или  Esc . Чтобы вернуть область кадрирования к исходному состоянию, достаточно
выбрать кнопку Сброс.

Кадрирование изображения

Параметры кадрирования:

Размеры рамки могут быть заданы через Отношение сторон или Сведение к размеру.

При включении чек-бокса Закадровая область не попавшие в кадр участки изображения будут залиты
вспомогательным цветом. Плотность заливки зависит от параметра Непрозрачность.
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НАЛОЖЕНИЕ ТЕКСТУРЫ

На выделенный объект можно наложить текстуру. Параметры эффекта регулируются на Панели настроек в закладке
Текстура.

Библиотека текстур

В комплекте с программой поставляется  Библиотека с большим количеством текстур. Для открытия  Библиотеки
необходимо дважды щелкнуть левой кнопкой мыши по квадрату с текстурой. Текстуры в Библиотеке разделены на
несколько групп, переключаться между которыми можно в списке. Для выбора текстуры из группы достаточно дважды
кликнуть по образцу левой кнопкой мыши.

Свои текстуры

Вместо текстур из библиотеки можно использовать свои текстуры.

Для загрузки отдельной текстуры в  AKVIS Decorator необходимо нажать на кнопку   и выбрать текстуру в

диалоговом окне открытия файла. Для возврата к настройкам без выбора текстуры нажмите на кнопку  .

Чтобы получить доступ ко всем текстурам из каталога пользователя, выберите в выпадающем списке пункт  Свои
текстуры и в нижней строке задайте путь к папке с текстурами. Кнопка   обновляет состояние списка текстур.
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Параметры настройки текстуры:

Угол (от -180 до 180). Угол поворота текстуры (в градусах). Отрицательное значение соответствует повороту
против часовой стрелки, положительное − по часовой стрелке.

Угол = 0 Угол = -45 Угол = -90

Масштаб (10-200%). Размер узора текстуры. По умолчанию масштаб текстуры равен 100%. Если задать масштаб
меньше 100%, размер узора на текстуре уменьшится, больше 100% − увеличится.

Масштаб = 50 Масштаб = 100 Масштаб = 155

Цвет (0-100). Позволяет получить текстуру в оттенках заданного цвета. Цвет можно выбрать щелчком по
цветовому квадрату.

Степень смешивания текстуры и цвета регулируется с помощью бегунка. При значении 0 перекрашивание не
выполняется, результат будет выведен в исходных тонах текстуры.
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Яркость = 70

 

Яркость = 120

 

Объём = 5

 

Объём = 35

 

Искривление = 10

 

Искривление = 90

Исходный цвет Синий цвет Розовый цвет

Параметры наложения текстуры:

Яркость (10-200). Позволяет осветлить или затемнить область эффекта. По умолчанию значение параметра
равно 100. Чем больше значение параметра, тем светлее будет изображение.

Объём (0-100). Глубина восприятия исходных градиентов. Параметр задаёт чувствительность текстуры к
световым перепадам на исходном изображении. Чем меньше значение параметра, тем более плоской и
однородной выглядит поверхность. С увеличением параметра градиенты становятся более выраженными.

Искривление (0-100). Степень искажения текстуры. При значении 0 искажений нет; чем больше значение
параметра, тем сильнее деформация узора.

Местоположение источника света. С помощью крестика на шаре задается вероятное расположение источника
света. Положение источника света влияет на искривление текстуры.

При нажатии кнопки Вернуть установки по умолчанию значения всех параметров будут сброшены до исходных.
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ИЗМЕНЕНИЕ ЦВЕТА

Выделенный объект можно перекрасить в другой цвет. Параметры эффекта регулируются на Панели настроек  в
закладке Цвет.

Цвет может быть выбран с Палитры цветов или из диалога выбора цвета. В первом случае достаточно щёлкнуть
левой кнопкой мыши по любому образцу цвета в палитре. Выбранный цвет будет показан как текущий (в большом
квадрате справа). Щелчок по квадрату левой кнопкой мыши активирует пипетку, с помощью которой цвет можно
выбрать с изображения. При двойном клике будет открыт стандартный диалог Выбрать цвет.

Пустые квадраты в правой части палитры предназначены для сохранения часто используемых цветов. Для заполнения
ячейки необходимо перетащить туда основной цвет. Щелчок левой кнопкой мыши по квадрату заменяет основной цвет
указанным, правой кнопкой - удаляет текущий цвет из ячейки.

 

Параметры наложения цвета.

Яркость (10-200). Позволяет осветлить или затемнить область эффекта. По умолчанию значение параметра
равно 100. Чем больше значение параметра, тем светлее будет изображение.
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Яркость = 60 Яркость = 140

Объём (0-100). Глубина восприятия исходных градиентов. Параметр задаёт чувствительность цвета к световым
перепадам на исходном изображении. Чем меньше значение параметра, тем более плоской и однородной выглядит
поверхность. С увеличением параметра градиенты становятся более выраженными.

Объём = 5 Объём = 40

При нажатии кнопки Вернуть установки по умолчанию значения всех параметров будут сброшены до исходных.
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НАСТРОЙКИ ПРОГРАММЫ

Диалог изменения настроек программы вызывается кнопкой   и имеет вид:

Язык программы. Для переключения интерфейса программы на другой язык необходимо выбрать язык из
выпадающего списка.
Масштаб интерфейса. В списке можно выбрать размер элементов интерфейса. При выборе значения  Авто
масштаб интерфейса автоматически подстраивается под разрешение экрана.
Интерфейс. Переключаясь между цветами, можно выбрать стиль оформления программы − светлый или темный.
Масштаб изображения при загрузке. Способ отображения открываемого файла.

- изображение масштабируется Под размер окна. Масштаб подгоняется так, чтобы оно было полностью
видимым в Окне изображения;

- при значении параметра 100% изображение не масштабируется. В большинстве случаев при открытии в
масштабе 100% в окне программы будет показана лишь часть изображения.

Последние открытые файлы. Количество файлов, отображаемых в списке недавно открытых документов при
правом клике мышью по кнопке   (сортированы по времени открытия). Максимальная длина списка − 30

файлов.
Выделение. Внешний вид областей выделения.

- "Марширующие муравьи". Области выделения обрамляются кривой в виде "бегущей" пунктирной линии.

- Заполнение цветом. Области выделения будут залиты цветом. По умолчанию Цвет заливки красный, но
его можно изменить, щелкнув по цветовой пластине и выбрав цвет из стандартного диалога  Выбрать
цвет.
Степень просвечивания областей выделения при заполнении цветом можно регулировать, изменяя параметр
Непрозрачность.

Отображение подсказок. В данном блоке задаётся местоположение окна подсказок.

- Справа на панели настроек;
- Слева под окном изображения;
- Не отображать.

Чек-бокс  Закрепить панель управления блокирует возможность сворачивания панели. Разблокированную
панель можно сворачивать и разворачивать щелчком по маленькой треугольной стрелке. Свёрнутая панель
всплывает при наведении курсора.

Для принятия изменений в окне Настройки нажмите ОК.

При необходимости можно вернуть исходные значения параметров, нажав на кнопку По умолчанию.
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ

Режим  Печать отвечает за подготовку изображений к распечатке на принтере. Перейти в режим печати можно
нажатием кнопки   на Панели управления.

Режим печати

Настроить печать выбранной фотографии можно с помощью параметров на Панели настроек:

В первом блоке из списка доступных принтеров выбрать нужный и указать необходимое разрешение, а также
задать количество печатных копий.

В блоке  Ориентация страницы задать положение листа при печати:  Альбомная  -  лист расположен
горизонтально или Книжная - лист расположен вертикально.

При нажатии на кнопку Параметры страницы открывается диалоговое окно, в котором можно выбрать размер и
ориентацию бумаги при печати, а также задать ширину полей печати.

Нажатием кнопки Сброс полей можно вернуть полям страницы исходные размеры.

В следующем блоке можно настроить размер изображения для печати с помощью параметров  Масштаб,
Ширина, Высота и Под размер страницы. Они не влияют на изображение, а только на его печатную копию.
Изменить размер печатной копии можно либо указав Масштаб изображения в %, либо задав новые значения для
параметров Ширина и Высота.

Чтобы распечатать изображение во всю страницу, следует выбрать чек-бокс Под размер страницы. Если чек-
бокс неактивен, то положение картинки можно задать с помощью стрелок справа или перетаскиванием мышью.

В блоке Рамка можно задать ширину и цвет рамки вокруг изображения.

В блоке Цветной фон с помощью цветовой пластины можно вызвать стандартный диалог выбора цвета и задать
цвет страницы.

В закладке  Страница можно настроить расположение одной или нескольких копий изображения на одной
странице.
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Печать страницы
С помощью параметра Копии указать количество копий обработанной фотографии на одной странице.
Параметрами  По горизонтали  и   По вертикали задать количество строк и столбцов для размещения
фотографий.
С помощью параметра Отступ задать ширину отступа между копиями фотографий.

На вкладке Постер можно настроить печать одного изображения на нескольких страницах для последующего
объединения в одно большое полотно.

Печать постера
Чек-бокс Страницы. При активном чек-боксе в поле справа можно задать количество страниц, на которое
будет поделена фотография. Масштаб изображения изменится, чтобы максимально заполнить все страницы.
При неактивном - программа автоматически подберет оптимальное число листов в соответствии с
фактическим размером изображения (масштаб = 100%).
Чек-бокс Поля для клея. При активном чек-боксе в поле справа можно задать ширину отступов для
склеивания листов. Отступы будут оставлены с правого и нижнего краев при печати страницы.
Чек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан номер ееЧек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан номер ее
позиции в столбце и строке.
Чек-бокс Линии отреза. При активном чек-боксе на полях страниц будут напечатаны линии, по которым
можно отрезать лишние части распечатанных листов.
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Для печати изображения с учетом настроенных параметров нажать на кнопку Печать. Для выхода из режима печати
нажать на кнопку Отмена.

При нажатии кнопки  Опции... будет открыт системный диалог, где можно произвести расширенную настройку и
отправить документ на печать.
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ТАКИЕ РАЗНЫЕ ЧАЙНИКИ

Один и тот же чайник может выглядеть совершенно по-разному, достаточно лишь «изменить» материал (цвет и
фактуру) с помощью AKVIS Decorator.

Исходное изображение Результаты

 

Шаг 1. Вначале необходимо взять чайник и сфотографировать его. Желательно выбрать чайник без рисунка.

Шаг 2. Затем откроем фотографию в любом графическом редакторе, с которым  совместим плагин  AKVIS
Decorator.
Шаг 3. Выделим на фотографии чайник (без ручки) с помощью любого инструмента выделения графического
редактора. Главное, чтобы выделять с помощью этого инструмента было удобно, а выделение было точным.

Выделение можно создавать и корректировать непосредственно в программе AKVIS Decorator.

Шаг 4. Вызовем плагин AKVIS Decorator и выберем в Библиотеке текстур подходящую текстуру. Мы выбрали
текстуру с сыром.
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Шаг 5. Нажмём на кнопку  . Расчёт займёт несколько секунд, и вот перед нами на закладке Обработка

«сырный» чайник.

И сразу же на ум приходят мысли о маленьком уютном домике на опушке леса где-нибудь в Швейцарии, о сырном
фондю и ароматном чае.

Шаг 6. А можно выбрать другую текстуру - например, тёмно-серую бумагу с рифлёным узором. Нажмём на
кнопку  .
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Шаг 7. Исходный чайник светлый, поэтому при наложении тёмной текстуры получился её светлый вариант. Для
того чтобы это исправить, необходимо уменьшить значение параметра Яркость.

После изменения любого из параметров наложения необходимо каждый раз нажимать на кнопку  , чтобы

результаты этих изменений отобразились в Окне изображения в закладке Обработка.

Шаг 8. Можно немного увеличить значение параметра Объём, чтобы распределение света и тени на чайнике
стало более выраженным, т.е. затенённые участки стали чуть темнее, а светлые, наоборот, светлее.

Этот снимок был сделан со встроенной в фотоаппарат вспышкой, следовательно, свет направлен на чайник
спереди, поэтому местоположение источника света на шаре менять не надо.
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Шаг 9. Применим результат, нажав на кнопку  . Простота узора и сдержанность цвета навевают мысль о

неторопливости чайной церемонии.

Щелкните по картинке, чтобы открыть рисунок в новом окне в большом размере

Примечание: Если выделение было выполнено не очень точно или нечёткие края объекта не позволили создать точное
выделение, то после применения плагина AKVIS Decorator можно пройтись по краю объекта размывающей кистью с
маленьким диаметром - например, использовать Размытие  с параметром Радиус размытия = 1,5.
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ПЕРЕКРАШИВАНИЕ ЖИВОТНЫХ

Автор примера Alvaro Salazar Chacon. Пример выполнен в редакторе AliveColors.

 

Там, где природа проявила сдержанность и скромность, человек решается на смелые эксперименты. С помощью
плагина AKVIS Decorator можно изменить текстуру кожи животных, маскируя их под другое существо, или придать
нашим знакомцам шутливую окраску.

 

Шаг 1. Выбрать фотографию животного и открыть её в графическом редакторе.

Исходное изображение
Шаг 2. Выделить те участки тела, на которых будет изменена фактура. Для этого используется инструмент
Новая фигура  (в режиме  Произвольная фигура), так как он позволяет реализовать самое точное

выделение и предотвратить ошибки.

Обведение по контуру
Шаг 3. Как только контур обведён, щёлкнуть правой кнопкой мыши по слою и в появившемся контекстном меню
выбрать пункт Растеризовать слой, а затем Добавить альфа-канал в выделение.
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Выделение области
Шаг 4. Вызвать плагин AKVIS Decorator. Для этого в AliveColors необходимо выбрать пункт меню Effects ->
AKVIS -> Decorator.

В библиотеке текстур имеется большое количество образцов, которые можно использовать для камуфлирования
- например, для переделки кожи слона в рыбью чешую.

Шаг 5. Нажать на кнопку   для запуска процесса наложения текстуры.

Наложение текстуры
Шаг 6. Если результат устраивает, нажать на кнопку  . Ниже приведены примеры использования декоратора

для получения различных окрасок.
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ЭКСПЕРИМЕНТЫ В ИНТЕРЬЕРЕ

AKVIS Decorator станет вашим помощником в выборе обивки диванов и расцветки ковров, поможет перекрасить стены
и сменить материал, из которого изготовлена корпусная мебель. Для экспериментов с интерьером нам понадобится
фотография в электронном виде.

Для увеличения картинки щёлкните по ней левой кнопкой мыши
Шаг 1. Откроем фотографию в графическом редакторе AliveColors. Мы выбрали фотографию кухни.

Шаг 2. Выделим дверцы кухонного шкафа, стоящего посередине.

Шаг 3. Запустим плагин AKVIS Decorator: Effects -> AKVIS -> Decorator.
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Шаг 4. Выберем из Библиотеки текстур подходящую текстуру.
Шаг 5. Нажмём на кнопку  , и дверцы шкафа приобретут совершенно другой вид:

Шаг 6. Применим результат, нажав на кнопку  .

Шаг 7. Снова возьмём исходную фотографию кухни и запустим плагин  AKVIS Decorator. Выберем другую
текстуру и нажмём на кнопку  . В этот раз мы выбрали тёмную текстуру.

Шаг 8. Исходный цвет шкафа светлый. Чтобы при наложении тёмной текстуры получить тёмные дверцы,
необходимо уменьшить значение параметра Яркость.
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Шаг 9. Если при наложении какой-либо текстуры станет плохо виден рельефный узор на стенках, то необходимо
увеличить значение параметра Объём.

Шаг 10. Применим результат, нажав на кнопку  .

Продолжая в том же духе, можно создать множество вариантов оформления собственной кухни.
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ИГРА С ЦВЕТОМ И ФАКТУРОЙ ОДЕЖДЫ

Изменить цвет блузки, однотонное платье сделать «в горошек», добавить декоративный орнамент, а у костюма
изменить цвет и фактуру ткани − теперь это очень просто с помощью AKVIS Decorator.

Исходное изображение Результат

Шаг 1. Открыть фотографию в графическом редакторе  AliveColors. Представим, что девушка очень любит
менять наряды.

Шаг 2. Вызвать из меню фильтров плагин AKVIS Decorator: Effects -> AKVIS -> Decorator.
Шаг 3. Выделить платье с помощью любого инструмента выделения.
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Шаг 4. Открыть Библиотеку текстур, дважды щелкнув левой кнопкой мыши по квадрату с текстурой, и в группе
Ткань выбрать подходящий материал.

Шаг 5. Не меняя параметры текстуры (угол поворота, масштаб, цвет), нажать на кнопку  . Расчёт займет

несколько секунд, результат наложения текстуры будет показан в закладке Обработка.

Подобрать параметры наложения текстуры (Искривление = 25) и снова запустить расчёт:
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Шаг 6. Применить результат, нажав на кнопку  . Окно плагина закроется, а в окне редактора появится

девушка в новеньком модном платье.
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ПРОГРАММЫ КОМПАНИИ АКВИС

 

AKVIS AirBrush — Аэрографический рисунок из фотографии

AKVIS AirBrush позволяет превратить фотографию в рисунок в технике  аэрография. Программа действует как
художественный фильтр, изменяя изображение и превращая его в аэрографический рисунок в соответствии с
выбранными настройками. Подробнее…

 

AKVIS Artifact Remover AI — Улучшение качества сжатых изображений JPEG

AKVIS Artifact Remover AI — программа для улучшения качества сжатых изображений. Программа использует
алгоритмы искусственного интеллекта для удаления артефактов сжатия JPEG и восстановления качества фотографий.
Включает 4 режима улучшения изображения, каждый из которых задействует уникальную нейронную сеть. Для
домашних пользователей доступна бесплатная версия. Для коммерческого использования необходима лицензия
Business. Подробнее…

 

AKVIS ArtSuite — Эффекты и рамки для фотографий

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий. ArtSuite содержит множество готовых
шаблонов и богатую Библиотеку образцов и текстур и позволяет получить практически бесконечное количество
вариантов эффектов. Подробнее…
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AKVIS ArtWork — Художественные стили и техники

AKVIS ArtWork имитирует художественные стили и техники живописи, создавая произведение искусства. В программе
представлены эффекты:  Масляная живопись, Акварель, Гуашь, Комикс, Перо и чернила, Линогравюра, Трафарет,
Пастель и Пуантилизм. Подробнее…

 

AKVIS Chameleon — Создание коллажей

AKVIS Chameleon — программа для создания коллажей, реалистичных и фантастических. Chameleon экономит время и
силы, так как не требует точного выделения объектов,  автоматически сглаживает границы и подбирает цветовую
гамму "вставки" к цветам фона. Подробнее…
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AKVIS Charcoal — Рисунок углем и мелом

AKVIS Charcoal позволяет преобразовать фотографию в рисунок, выполненный углём и мелом. Изменяя цвета
материалов и бумаги, можно получить массу самых разнообразных эффектов, например, рисунок сангиной.
Подробнее…

 

AKVIS Coloriage AI — Раскрашивание изображений

AKVIS Coloriage позволяет раскрашивать черно-белые фотографии и заменять цвет на цветных изображениях,
выполнять выборочное раскрашивание и обесцвечивание. С помощью программы можно вернуть к жизни старые снимки
и придать современной фотографии винтажный вид. Подробнее…

 

AKVIS Decorator — Замена текстуры и перекраска поверхности

AKVIS Decorator — программа для изменения поверхности объекта. Decorator позволяет заменить текстуру либо цвет
выбранного объекта. При наложении текстуры сохраняется объем, изгибы, тени исходного изображения. В программе
представлена богатая Библиотека текстур:  образцы поверхностей дерева, металла, камня, травы, тканей и др.
Подробнее…
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AKVIS Draw — Создание карандашного эскиза

AKVIS Draw позволяет превратить фотографию в эскиз, выполненный простым карандашом. Программа имитирует
видение и подход истинного художника. С помощью AKVIS Draw вы можете придать любому изображению вид быстрого
карандашного наброска. Подробнее…

 

AKVIS Enhancer — Фотокоррекция с усилением детализации

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. Программа позволяет
проявить детали в светлых и темных областях, улучшить резкость и контрастность изображения, добавить яркость,
отредактировать отдельные цветовые области. Программа работает в трех режимах: Улучшение деталей, Допечатная
обработка и Тоновая коррекция. Подробнее…

 

AKVIS Explosion — Эффекты разрушения и распада

AKVIS Explosion добавляет на фотографии эффекты разрушения. Программа позволяет распылить объект на осколки,
превратить часть изображения в россыпь летящих частиц, создать песчаную бурю, имитировать взрыв и другие
эффекты распада. Подробнее…
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AKVIS Frames — Готовые рамки для фотографий

AKVIS Frames — бесплатная программа для оформления фотографий. Программа предназначена для работы с
пакетами рамок AKVIS. Вы можете украсить свои снимки эксклюзивными стильными рамками! Подробнее…

 

AKVIS HDRFactory — Расширение динамического диапазона

AKVIS HDRFactory — программа для создания изображений с расширенным динамическим диапазоном (HDR) из одного
или нескольких снимков, а также для коррекции яркости, контрастности, насыщенности. HDRFactory наполнит жизнью
и цветом ваши фотографии! Подробнее…

 

AKVIS Inspire AI — Художественная стилизация изображений

AKVIS Inspire AI выполняет стилизацию изображений под различные образцы живописи. Эта программа на основе
искусственного интеллекта применяет на фотографию цветовую гамму и стиль выбранного произведения искусства,
создавая новый шедевр. Программа включает в себя галерею художественных стилей и позволяет загружать свои
образцы. Имитируйте стиль известных художников! Подробнее…
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AKVIS LightShop — Световые и звездные эффекты

AKVIS LightShop добавляет световые эффекты на изображение. С помощью программы можно создать любого вида и
формы свечения, добавить на фотографию лучи, ореолы, вспышки, молнии, блики на объекты, закат или фейерверк.
LightShop украсит снимок, оживит пейзаж, изменит время суток и погоду. Подробнее…

 

AKVIS Magnifier AI — Увеличивайте и улучшайте изображения

AKVIS Magnifier AI позволяет увеличить размер изображения и улучшить качество. Благодаря использованию
нейросетей программа обеспечивает многократное увеличение, до 800%, и создает изображения высокого разрешения.
Улучшайте разрешение фотографии, создавайте четкие изображения идеального качества, с отличной детализацией!
Подробнее…

 

AKVIS MakeUp — Ретушь портретных фотографий

AKVIS MakeUp — программа для исправления портретных фотографий. MakeUp улучшает портрет, устраняя мелкие
дефекты с поверхности кожи и придавая лицу сияние, чистоту и гладкость. Программа способна превратить обычный
снимок в фотографию с обложки, создать стильный образ и даже получить изображение в "высоком ключе".
Подробнее…
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AKVIS NatureArt — Природные явления на ваших фотографиях

AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления. В программу включены
эффекты: Дождь

 

AKVIS Neon — Рисунок светящимися линиями

AKVIS Neon превращает фотографию в яркий и необычный рисунок, выполненный светящимися линиями. Программа
предназначена для создания неоновых эффектов на изображении. Подробнее…
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AKVIS Noise Buster AI — Удаление цифрового шума

AKVIS Noise Buster AI — программа для подавления цифрового шума. Программа убирает шумы матрицы цифровой
камеры и шумы, появляющиеся при сканировании фотоснимка, уменьшает зернистость и устраняет неоднородные
цветовые пятна на изображении, сохраняя при этом детали и чёткость границ. Программа использует технологии
искусственного интеллекта и настройки постобработки для усовершенствования результата. Подробнее…

 

AKVIS OilPaint — Эффект масляной живописи

AKVIS OilPaint — программа для имитации масляной живописи. Особенностью программы является уникальный
алгоритм наложения мазков, который наиболее достоверно воспроизводит технику работы кистью. Подробнее…

 

AKVIS Pastel — Рисунок пастелью из фотографии

AKVIS Pastel позволяет преобразовать обычный фотоснимок в рисунок, выполненный пастелью. Программа превращает
любое изображение в произведение искусства, имитируя одну из самых популярных художественных техник,
обладающую графическими и живописными свойствами. Подробнее…
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AKVIS Points — Картины в технике пуантилизма

AKVIS Points превращает фотографии в картины в одной из самых выразительных живописных техник — пуантилизм. С
помощью программы Points вы с легкостью можете создавать великолепные произведения искусства в манере
пуантилистов. Откройте для себя мир ярких красок! Подробнее…

 

AKVIS Refocus AI — Улучшение фокусировки, эффекты размытия

AKVIS Refocus AI повышает резкость нечетких фотографий, предлагает полную и выборочную фокусировку, добавляет
эффекты размытия и боке. Программа работает в пяти режимах:  Исправление фокуса AI, Миниатюра, Размытие
диафрагмы, Размытие движения и Радиальное размытие. Подробнее…

 

AKVIS Retoucher — Восстановление и ретушь фотографий

AKVIS Retoucher — программа для восстановления изображений и ретуши фотографий.

Программа поможет удалить царапины, пятна, пыль, следы от сгибов и другие дефекты; убрать лишние детали, текст;
реконструировать недостающие части фотографии, "затянуть" дырявые места и нарастить оборванные края.
Подробнее…
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AKVIS Sketch — Рисунок карандашом из фотографии

AKVIS Sketch — программа для создания рисунка из фотографии. Программа превращает фотоснимки в эскизы,
сделанные карандашом или углем, позволяет создать черно-белый карандашный набросок или цветной рисунок. В
программе представлены следующие стили:  Классический, Художественный, Маэстро  и   Мультистиль, — каждый с
набором готовых пресетов. AKVIS Sketch позволяет каждому почувствовать себя художником! Подробнее…

 

AKVIS SmartMask — Выделение объекта и удаление фона

AKVIS SmartMask — программа для быстрого выделения объектов на изображении. SmartMask позволяет быстро и
качественно вырезать часть фотографии, используется для удаления фона, создания коллажей. Подробнее…
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AKVIS Watercolor — Рисунок акварельными красками

AKVIS Watercolor превращает фотографию в акварельный рисунок. Программа включает в себя два стиля:
Классическая акварель  и   Контурная акварель, каждый с набором готовых пресетов. Создавайте произведения
искусства в технике акварельной живописи! Подробнее…
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